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We at the Directorate of Technology and Information System 
Development (DPTSI) of ITS are committed to providing access to 
technology and information systems for the entire ITS academic 
community. DPTSI is responsible for IT operations and the development 
of information systems at ITS. To support digital transformation in the 
era of Industry 4.0, we offer intelligent IT services, reliable 
infrastructure and network services, application and digital platform 
services, as well as big data technology management services.

This Starter Guide Book is presented as an effort to provide essential 
information for users of our services, making it easier for everyone to 
access and utilize the systems available. We hope this guide helps 
users navigate and benefit from the digital services at ITS more 
efficiently.

We would like to express our sincere gratitude to all team members 
and contributors who have worked together to complete this book. May 
all the efforts made be considered good deeds and bring meaningful 
rewards. This book is by no means perfect, and with all humility, we 
welcome any feedback or suggestions from readers to help us improve.

Foreword

Welcome to ITS Campus.

Happy reading, and we hope you find it useful.

Surabaya, July 3, 2025



1. Open the myITS Portal.
2. Search for and select the myITS 

VPN service.
3. Download and install the OpenVPN 

Connect Client (minimum version 
3.4.2).

4. Download the myITS VPN profile.
5. Import the profile into the installed 

OpenVPN Connect Client.
6. Log in using your ITS email address 

as the username and your email 
password.

7. Check the "Save Password" option 
for easier future access.

8. Activate the VPN by toggling the 
"OpenVPN Profile myITS VPN" 
switch.

For detailed instructions, please visit:
https://its.id/AksesVPN
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myITS Portal is a Single Sign-On (SSO) 
portal used to access various 
ITS-owned applications and services. 
Accessing the myITS Portal is a 
mandatory first step for all new ITS 
students to take full advantage of the 
applications and services provided by 
the university.

Through the myITS Portal, students 
can access several essential 
applications such as the Academic 
Information System (SIAKAD), myITS 
Classroom, myITS Attendance, myITS 
StudentConnect, and many more.

Upon admission to ITS, each student is 
automatically provided with an official 
ITS email account in the format 
nrp@student.its.ac.id. This email is 
used to log in to the myITS Portal and 
also functions like a regular email 
account—for sending and receiving 
messages—using Microsoft Outlook.

After successfully logging in to myITS 
Portal, new students are required to 
change their password to ensure the 
security of their account and personal 
data. 

The first step to accessing the myITS 
Portal is logging in by following these 
steps:
1. Visit the official portal at myITS 

Portal.
2. Enter your ITS email as listed on 

the SIPMABA page.
3. Enter the default password 

provided on the SIPMABA page. This 
password is only valid for your first 
login to the myITS Portal.

4. Click "Sign In."
5. Activate Multi-Factor

Authentication (MFA) by following 
the instructions on page 5 of this 
guide or visiting 
its.id/PanduanAktivasiMFA.

MYITS PORTAL

LOGIN MYITS PORTAL

Changing Your myITS 
Portal Password
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There are several rules for creating a 
new password to prevent unauthorized 
access:
• Must not be the same as your 

previous password.
• Minimum of 8 characters.
• Use a combination of uppercase 

letters, lowercase letters, and 
numbers. Symbols (such as 
!@#&$%^&*) are optional but 
strongly recommended for added 
security.

• Must not contain your 
username/myITS ID or any part of 
your full name.

• Avoid common passwords such as: 
12345, admin123, semangat, abcde.

• Do not include your date of birth or 
student identity in the password.

• Passwords must not contain 
spaces.

• Example of a strong password: 
4Nt4its!

1. Open the Account or Manage 
Account menu.

2. To verify your alternate email, 
select the Email section.

3. Click the pencil icon next to 
“Alternate Email,” then enter your 
personal email address (an active 
email from Gmail, Yahoo, or other 
providers).

4. Check your inbox for a verification 
message, then click Verify Email in 
the message.

5. To verify your mobile number, go to 
the Phone Number section.

6. Enter an active mobile number 
using any provider except XL, Tri 
(3), Smartfren, or Indosat, then 
click Save.

7. Wait for an SMS from the system 
sent to your registered number.

8. Enter the OTP code provided in the 
message.

9. If the status changes to “Verified”, 
your alternate email and mobile 
number have been successfully 
verified.

The next step for new students is to 
verify their alternate email and mobile 
number through the Account menu.

You can easily change your password 
through the Change Password menu in 
the myITS Account application. Here 
are the steps:
1. Enter your new password.
2. Confirm your new password.
3. Once saved successfully, please 

wait approximately 5 minutes 
before logging back in to the myITS 
Portal to allow the system to 
complete synchronization.

Verifying Alternate 
Email and Mobile 
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The Academic Information System 
(SIAKAD) is an application within 
myITS Portal that provides academic 
services and information. It includes 
features such as student biodata, 
academic transcripts, course 
registration (FRS), academic advising, 
and the submission of various 
academic requests.

myITS Classroom is the learning 
management system (LMS) used for 
lectures at ITS. It utilizes 
internet-based learning tools that can 
be accessed by students anytime and 
anywhere.

You can access myITS Classroom 
through the myITS Portal or directly by 
visiting https://classroom.its.ac.id.

For more detailed guidance on using 
myITS Classroom, please visit:
https://its.id/myITS_Classroom

myITS Presensi is an information 
system that manages student 
attendance in lectures. It ensures that 
attendance is recorded accurately and 
efficiently for academic purposes.

You can access myITS Presensi via the 
myITS Portal or directly at 
https://presensi.its.ac.id.

For further guidance on how to use 
myITS Presensi, please visit:
https://its.id/myITS_Presensi

When accessing SIAKAD for the first 
time, new ITS students are required to 
verify their personal and 
parental/guardian data by entering 
their personal email, mobile number, 
and the mobile number of their parent 
or guardian. This parental data 
verification is necessary to enable 
access to the myITS Wali application.

Verification Steps:

1. Log in to the myITS Portal, then 
search for and open SIAKAD.

2. To verify your email and phone 
number, go to Data > Biodata > 
Verify Biodata.

3. .Fill in the student personal data 
form, then click Save.

4. Open the Parent/Guardian tab, 
complete the required information, 
then click Save.

5. Ensure that the parent's/guardian's 
mobile number and date of birth 
are correct so they can 
successfully log in to the myITS 
Wali application.

Academic Information 
System (SIAKAD)

MYITS CLASSROOM

MYITS PRESENSI
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ITS provides two internet services that 
students can use on campus: myITS-WiFi 
and Eduroam. Connecting to these 
campus internet networks is simple:
1. Search for and select the desired 

network.
2. Enter your official ITS student email 

address.
3. Enter the password associated with 

your ITS email account.Click Connect.

Multi-Factor Authentication (MFA) is a 
login process that requires users to 
provide additional verification beyond 
just a password. This could include using 
a fingerprint or entering a code sent to a 
registered phone number.

MFA activation is mandatory for all ITS 
members, including students. It helps 
protect user data and enhance account 
security against cyber threats.

MFA is usually activated during the first 
login to the myITS Portal. However, if it 
was not activated at that time, students 
can follow the steps below to activate it:

1. Before starting the activation, 
download the Microsoft 
Authenticator app from the Play 
Store or App Store on your mobile 
phone.

2. Open myITS Portal using a laptop.
3. Go to the Account menu, then select 

Multi-Factor Authentication. You will 
be redirected to the myITS Single 
Sign-On page.

4. Click “Add sign-in method”, then 
select Microsoft Authenticator.

5. Click “I want to use a different 
authenticator app”, then click Next.

6. Scan the QR code displayed on the 
laptop screen using the Microsoft 
Authenticator app on your phone.

7. Enter the code shown on the laptop 
screen into the app, then click Next.

8. If prompted to enter a code from the 
Microsoft Authenticator app, input 
the 6-digit code displayed under your 
account details in the app into the 
provided field on the laptop.

9. Click “Yes” on the Stay signed in 
dialog box to avoid repeated login 
verifications.

For more detailed guidance, please visit:
http:// i ts . id/PanduanAkt ivas iMFA

The Microsoft Authenticator app must 
not be uninstalled, as it will be 
continuously required to access the Office 
365 portal.

INTERNET ACCESS

MULTI-FACTOR 
AUTHENTICATION (MFA)
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For more detailed guidance on accessing 
ITS Internet services, please visit:

https://its.ac.id/dptsi/akses-internet- 
kampus-mahasiswa/

https://its.id/PanduanKoneksiEduroam



Office 365 provides access to the latest version 
of Microsoft Office (both online and offline), 
OneDrive, and various other collaboration tools. 
Students can access these services through the 
myITS Portal by searching for and selecting 
Office 365 Portal, which will redirect them to the 
Microsoft 365 homepage. 

OFFICE 365
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Students who wish to install the desktop 
version of Office 365 can do so from the 
"Install and more" section in the Office 365 
Portal.

For detailed installation instructions, 
please visit:
https://its.id/InstalasiAplikasiMicrosoft365

For detailed instructions, please visit:
https://its.id/InstalasiAplikasiMicrosoft365

After completing the installation, 
students must activate Office 365 
before using the applications. Follow 
these steps:

1. Open any Office 365 application on 
your desktop (such as Microsoft 
Word, Excel, etc.).

2. Go to the File menu, then select 
Account.

3. Click Sign In and log in using your 
ITS email and email account 
password.

4. Complete the authentication by 
entering the code through the 
Microsoft Authenticator app.

Benefits of Using Office 365 for 
Students:

• Always have access to the latest 
online version of Office apps such 
as Word, Excel, and PowerPoint.

• Download the latest offline version 
of Office from the Office portal.

• Download other Office 365 
products such as Skype for 
Business, OneDrive for Business, 
and more via the portal.

• Simplifies collaboration among the 
academic community at ITS.

• Use official and licensed Office 
products through proper 
activation. 

INSTALLING OFFICE 365 ACTIVATING OFFICE 365
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In addition to using the desktop 
(offline) version, students can also 
access Office applications online 
through the Office 365 Portal.

For example, to access their ITS email, 
students can use Microsoft Outlook, 
which can be found by using the 
Search feature on the Home menu, or 
by navigating to the Apps menu and 
selecting Outlook.
The same steps apply when accessing 
other Office applications online.

ITS VPN is a service available to all 
members of the ITS community, 
including students. It allows users to 
securely access the campus network 
and internal resources from outside 
the ITS campus environment.
To use the ITS VPN service, follow 
these steps:

ACCESSING 
APPLICATIONS 

ITS VPN ACCESS
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If the word LICENSED appears, your 
account is now fully licensed and 
ready for unlimited use.

For detailed guidance, please visit:
https://its.id/AksesZoom

ITS provides licensed Zoom accounts 
for all members of the ITS community, 
including students. With a licensed 
Zoom account, users can host online 
meetings without time limits and with 
a larger participant capacity.
To activate your licensed Zoom 
account, follow these steps:
1. Open the myITS Portal.
2. Search for and select the Zoom 

service.
3. Choose Sign in with myITS SSO.
4. Enter your ITS email address and 

email password.
5. Complete the authentication 

process using the Microsoft 
Authenticator app.

6. Click your profile photo at the 
top-right corner of the Zoom 
homepage.

myITS Wali is an application that 
allows parents or guardians to digitally 
monitor their child's academic 
progress, providing real-time access to 
academic records, course schedules, 
and important notifications.

myITS Wali can be accessed at:
https://wali.its.ac.id

For detailed guidance, please visit:
https://its.id/PanduanmyITSWali

ITS provides strong academic support 
through various facilities designed to 
enhance students' study and research 
activities, including the ITS Library and 
the Directorate of Research and 
Community Service (DRPM).

The ITS Library offers a wide range of 
services, facilities, and physical and 
digital resources that are both modern 
and comprehensive. Students can 
access books, journals, theses, and 
other resources either in person or 
online, using services such as:
• OBOR (Online Book Order) – for 

requesting and borrowing books 
online.

• E-Resources Delivery – for 
requesting journal articles and 
books without having to visit the 
library in person.

• Other support services are also 
available.

ZOOM ACCESS MYITS WALI

STUDY AND 
RESEARCH

8



The library is equipped with facilities 
that support a comfortable and 
productive study environment, 
including:

• Public computers
• Laptop lending services for 

students who need extra devices
• Printing services
• Reading rooms with various 

concepts, such as the Silent Study 
Room for quiet individual study, 
and Group Discussion Rooms 
equipped with whiteboards and 
projectors

• Relaxation areas and a café where 
students can take short breaks 
between study sessions

For more information, students can 
access the Ask A Librarian online 
service or visit:
https://its.ac.id/perpustakaan

Meanwhile, students interested in 
conducting research or community 
service projects can contact DRPM, 
which acts as a facilitator providing:
• Research funding and guidance
• Support for research 

commercialization and community 
application

• Opportunities for collaboration 
with external institutions

• Assistance with scientific 
publications such as journals and 
conference proceedings

All research activities are managed 
through SIMPel ITS (ITS Research 
Information System), covering every 
stage from proposal submission and 
selection announcements to progress 
reporting and research outputs.

For more details, students can visit the 
DRPM website at:
https://its.ac.id/drpm/id/direktorat-ris
et-dan-pengabdian-kepada-masyarak
at-its/

ITS is committed to creating an 
inclusive and supportive learning 
environment for all students, including 
those with special needs. To support 
this commitment, ITS provides various 
facilities and services specifically 
designed to accommodate students 
with disabilities.

For more information, please visit:
https://its.id/PanduanLayananMahasis
waDisabilitas

FACILITIES AND SERVICES 
FOR STUDENTS WITH 
SPECIAL NEEDS

9



ONLINE
https://servicedesk.its.ac.id/

EMAIL
humas@its.ac.id

INSTAGRAM
@its_campus
@itsdptsi

PHONE
031-5994251-54 
031-5947274
031-5945472

FAX
031-5923465
031-5947845

CONTACT US


